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PowerINSPECT OMV performs rapid part verification on a machine 
tool — a process known as On Machine Verification (OMV). This allows 
you to spot problems while the part is still on the machine tool. 

Choosing what to inspect 
PowerINSPECT OMV's inspection sequence specifies the features to 
be inspected and the order of inspection. You can add features to 
the inspection sequence by picking them from a CAD model, or by 
selecting them from the Item toolbar. 

What can you measure? 
You can measure the following types of feature on the part: 

 Surfaces. 

 Geometric features, including 2D features (such as circles) and 
3D features (such as cones). 

Aligning the part 
PowerINSPECT OMV provides several methods of aligning the part 
to the CAD model: 

 From File alignment — Loads a previously saved alignment from 
file. You can use this option when inspecting multiple examples 
of a part. When you use this alignment, each example must be 
identically positioned on the inspection table. 

 Geometric PLP alignment — Creates an alignment using 
geometric features that have known nominal coordinates. 

 Reference Point System (RPS) alignment — Creates an alignment 
using the coordinates of up to one hundred features. 

Introduction to 
PowerINSPECT OMV 
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 User Defined alignment — Aligns the part by specifying the 
relationship between the reference systems of the Machine 
Datum and the PCS (CAD Datum). 

When you have measured one or more inspection, section or point 
cloud groups, you can use Best Fit items to optimize the alignment 
of the part with the CAD model. PowerINSPECT OMV compares the 
points of selected groups to the nominals and adjusts the alignment 
using one of five fitting methods. 

Inspecting the part 
You perform inspections by exporting the inspection sequence as an 
NC Program, and then running the program on the machine tool. 
When the inspection is complete, you import the measurements into 
PowerINSPECT OMV for a detailed analysis of the results, including 
deviations from the nominals and the positions, sizes, and form of 
geometric features. 

You can export NC programs and import results using a real-time 
connection with a serial cable, or by transferring a file of points to 
the measuring device. 

Viewing the results 
PowerINSPECT OMV provides several types of feedback:  

 Inspection points and labels displayed in the CAD view use 
colour-coding to identify which items are within tolerance, above 
tolerance, and below tolerance.  

 The Info tab provides full details of the selected item in the 
inspection sequence, including position, size, form value, and 
deviation from nominal information.  
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 The Report tab produces a customizable HTML report. In it, you 
can show all measurements for all features in your inspection, or 
you can choose which measurements to include. You can also 
generate printable reports using a PDF generator or Microsoft 
Excel. 
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PowerINSPECT OMV uses a standard method for identifying the 
features to be measured, building a measurement program and 
collecting measurement data, so you can use the same process for 
inspecting any type of part. The process for creating an inspection is 
detailed in the following steps:  

1 Using the New Document Wizard, create an inspection document, 
and, if available, load the CAD model for the part you want to 
inspect. 

2 In the Machine tab, specify the probe assemblies with which you 
want to inspect the part. 

3 In the Sequence Tree tab, create an alignment for the part and 
specify the features to be inspected. For each feature, you must 
specify the points to be measured and the points to be probed. 

4 In the Simulate Program tab, check the inspection sequence, and 
correct any problems. 

5 In the NC Program tab, export the inspection sequence to an NC 
program file. 

6 Transfer the NC Program file to the machine-tool controller. You 
can transfer the file using a memory stick, or a serial or network 
link between your computer and the machine controller. 

7 Run the NC Program file on the machine tool. 

8 In the NC Program tab, import the measurements into 
PowerINSPECT OMV.  

 If you are using a serial or network link, you may be able to 
import each point as it is taken. 

9 View the results inPowerINSPECT OMV using the Info and Report 
tabs.  

 

The OMV process 
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This section describes how to: 

 create an inspection (see page 6). 

 understand the PowerINSPECT OMV screen layout (see page 7). 

 manipulate the CAD model on the screen (see page 9). 

 specify the probe and probe tools to be used to perform the 
inspection (see page 10). 

 

Tutorial example 
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Creating an inspection document 
1 Select the File > New Document Wizard menu option or click  

in the OMV Main toolbar to display the New Document Wizard. 

2 Select Measurement with a single CAD part to create an inspection 
using a CAD model. 

3 Click Next. 

 
4 Click New and select knife.odx in the Samples folder. 

5 Click Finish to open the new document and display the model in 
the CAD View tab. 
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Understanding the screen layout 
The main features of the screen are shown below: 

 
  
Area Description 

  The Sequence Tree tab lists the measured features. 
 The Run tab controls simulation of the inspection 

sequence, and the export of NC Program to, and import 
of data to from the machine tool. 

 The CAD tab contains details of the CAD file displayed in 
the main CAD view. 

 The Machine tab controls simulation of the probe and 
stylus. 



 

8 • Tutorial example PowerINSPECT OMV 2016 Quick Start Guide  

Area Description 

  The Features tab specifies features and probe paths. 
 The Geometry Explorer tab shows details of features 

picked for inspection using the Wireframe Checker - see 
. 

 The Shading options can aid visualization of the model. 

 The Label options display nominal and measurement 
information in the CAD View tab. 

 
The Wireframe Checker  button enables you to add 
items to the inspection sequence by picking geometric 
features directly from the CAD model. 
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Manipulating the CAD view 
You can change the CAD view using the mouse and keyboard: 

 
To… Use… 
Zoom in and out of the CAD 
view. 

 or  

Zoom in on an area by 
drawing a box around that 
area.  or  or   

Pan the CAD view. 

 or  

Rotate the CAD view. A 
globe is displayed in the 
CAD view to show the 
direction of rotation. 

 or   

 

Where: 

 The mouse button in red indicates which button you must press: 

      
 One or more keys indicates you must press these keys on your 

keyboard at the same time as pressing a mouse button: 

   
 The blue direction arrow indicates you must rotate the mouse 

wheel: 
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Specifying the machine tool details 
The Machine tab specifies the details of the probe and the probe 
tools to be used to perform the inspection. This enables 
PowerINSPECT OMV to generate a graphical simulation of the probe 
paths so you can check for any problems.  

To specify the machine tool details: 

1 Select the Machine tab. 

2 In the Probe and Probe tool sections, select the probe and stylus 
with which you want to measure the part.  

3 Click Export As Default at the bottom of the Machine tab so that 
the probe and stylus you picked are automatically selected when 
you create new inspection documents. 

The Machine tab details are recorded in the .pwi file when you save 
an inspection, and are reloaded when you next open it. 
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Aligning the CAD model to the part 
If you want to compare the measurements of the part with its 
nominal values, you must first align it to the CAD model. This 
matches the model to the part, and enables PowerINSPECT OMV to 
report whether measured features are in or out of tolerance. 

You can create several different types of alignment in 
PowerINSPECT OMV; which one you choose depends on the part 
and your requirements. This section describes how to create a 
Geometric PLP alignment, which uses three geometric features, a 
Plane, a Line and a Point, to fix the position of the part in the X, Y, 
and Z axes. The following sections describe how to create these 
items and how to use them to create an alignment. 

Before starting, click  below the Shading mode button in the 
CAD View toolbar (on the right of the PowerINSPECT OMV window), 
and select the Show shaded and wireframe option. 

 
This shades the CAD model and makes it easier to see the surfaces 
and features you are working with. 
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Stage 1: Delete the default alignment 
By default, PowerINSPECT OMV aligns the CAD model using an 
alignment saved to a file. In this example, however, we are going to 
create an alignment based on a plane, a line and a point (PLP), so 
we first need to delete this default alignment. 

To delete the default alignment: 

1 Select the Sequence Tree tab. 

2 Select the default alignment in the inspection sequence. 

 
3 Press the Delete key on the keyboard. 

 

Stage 2: Create a geometric group 
In PowerINSPECT OMV, geometric items are stored in geometric 
groups. These enable you to organize the inspection sequence, and 
to keep related items together. The first step in aligning a part to its 
model is to create a geometric group for the items used in the 
alignment. 

To create a geometric group: 

1 In the Item toolbar, click the Geometric Group button.  
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The Geometric Group dialog is displayed. 

 
This dialog specifies the name of the group. It also specifies 
whether the measurements of the items it contains are to be 
displayed in the CAD view; the default tolerances for items 
created in the group; and the coordinate system relative to 
which the measurement results are to be reported.  

2 Click OK to accept the default settings for the group.  
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The group is added to the inspection sequence and automatically 
opened. The Active Group list at the top of the Sequence Tree 
changes to display the name of the group, and the Item toolbar is 
replaced with the Geometry toolbar, which enables you to add 
geometric items to the inspection sequence.  

 
 

Stage 3: Create a probed plane 
The first item required in a Geometric PLP Alignment is the plane. In 
this example, it is used to specify the orientation of the part's 
Z plane.  

To create a probed plane: 

1 In the Geometry toolbar, click the Probed Plane button. 

 
2 Double-click near three corners of the CAD model to define the 

plane. 

 
The details of the plane are displayed in the Features tab 
underneath the inspection sequence. 
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3 In the Features tab, make sure that the UserDefined probing 
method of Optimal is selected.  

4 Click  and enter a Safe Height of 40, so the probe lead-in and 
lead-out clears the middle of the model. 

 

5 Click  to confirm the details of the plane. The plane is added 
to the group and displayed in the inspection sequence. 

 
An icon  is shown on the item to indicate it is unmeasured. 

6 If you want to hide the plane in the CAD view, click the bulb  
icon in the inspection sequence. Click the icon again to redisplay 
the plane. 

 

Stage 4: Create a probed line 
The next item required for the alignment is a line. In this example, 
it is used to specify the orientation of the part's X plane.  

To create a probed line: 

1 Rotate the model (see page 9) to display its back face. 

2 In the Geometry toolbar, click the Probed Line  button and 
double-click near each end of the back face to define the line. 
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As before, the details of the line are displayed in the Features 
tab. 

3 Select the AutoTouchTrigger probing method of Optimal. This 
specifies that you want PowerINSPECT OMV to automatically 
create the line's probe path. 

 
By default, the AutoTouchTrigger probing method of Optimal 
creates six probe points and spaces them equally along the line 
you created. Click  to display the Parameters dialog, then 
select the Points row and click the spin buttons to change the 
default number to 4. 

 

Click  to save your changes. 

4 Click  and type 3 in the Depth box. 

 

5 Click  and type 40 in the Safe height box. 
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6 Click  to confirm the details of the line. 

 
 

Stage 5: Create a circle 
In addition to selecting the items you want to inspect and then 
specifying the probe points to be used, you can pick the features 
you want to inspect from the CAD model. This section demonstrates 
how to pick the circle item that used for the alignment. 

To create a probed circle: 

1 Select the Wireframe Checker  button in the Mouse Context 
toolbar. 

 
2 Move the mouse cursor over the CAD model. As you move the 

cursor, different features are highlighted in yellow.  

3 Move the cursor over the circle shown below, and click the left 
mouse button to select it. 

 
This creates a probe path, highlights the feature, and displays its 
details in the Features tab. 
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4 Click  and enter a Depth of 3. Click  and enter a Safe 
Height of 40.  

 

5 Click  to confirm the details of the circle. You have now 
specified the items required to align the CAD model with the 
part. 

 

Stage 6: Create a PLP alignment 
Geometric PLP alignments align a part to its model using a plane, 
line, and point for which you know the nominal coordinates. This 
type of alignment allows you to modify the alignment by amending 
the details of the geometric items or by remeasuring them 
individually. 

To create the alignment: 

1 Click  at the top of the Sequence Tree to close the geometric 
group.  

The Active Group list changes to Definition to show you have 
closed the group and are working with the top-level of the 
inspection sequence.  
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2 In the Item toolbar, click the Geometric PLP  button to create 
a PLP alignment based on the features you selected. 

 
The Geometric PLP Alignment dialog is displayed. It automatically 
selects the items you defined and loads the nominals of the Point 
item. 

 
3 Click OK to close the dialog and confirm you want to create the 

alignment using the default selections.  
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Working with probe paths 
Probe paths control the movements and orientation of the probe 
while measuring a part. Before you export the inspection sequence 
to the machine tool for measurement, you must check the paths 
and correct any problems, such as collisions between the probe and 
the part. This section describes how to: 

 Spot problems in the inspection sequence (see page 21).  

 Simulate the inspection sequence (see page 23). 

 Fix probe path faults (see page 24). 
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Verifying probe paths 
By default, PowerINSPECT OMV checks the probe path of each item 
in the inspection sequence and displays one of the following icons to 
indicate its verification status: 

  
Icon Description 

  the probe path is unverified.  
This is displayed only when editing an item or simulating a probe 
path. 

  the probe path contains no verification faults. 

 the collision check for the path is invalid. 

 the probe path contains a collision between the probe and the part. 
If a path contains both a collision and an out-of-bounds fault, only the 
out-of-bounds fault is displayed. 

  the probe path contains a missing contact. 

  the probe path contains an illegal contact. 

 the probe path contains an out-of-bounds move.  

 the probe or probe head specified for a probe path cannot be found. 

  

 Probe orientation changes and link moves between probe 
paths that are automatically created by PowerINSPECT OMV 
are not verified. 

If any probe path faults are found, you must fix them (see page 24) 
before running the inspection sequence on a measuring device: 

 You can view the location of an item's probe path faults by 
selecting the item in the inspection sequence. This displays its 
probe path and any faults in the CAD view. For example: 
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 You can view the details of all the faults for an item by selecting 
the item in the inspection sequence and then clicking the Info 
tab. For example: 

 

 Probe path verification is enabled by default. Select the Tools 
> Probe Path Verification menu option to deactivate it. Select 
the menu option again to reactivate it. 
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Simulating measurement 
The Simulate Program tab enables you to simulate all or part of the 
inspection sequence. Use it to visualize how the inspection and to 
check for problems in the probe path before running the sequence 
on the measuring device.  

To simulate the inspection sequence: 

1 At the top of the Sequence Tree, select the Run tab. 

2 Select the Simulate Program tab. 

 
3 If the probe is not visible in the CAD view, press the F11 key to 

display it.  

4 Deselect the Stop on error check box. 

5 Click  to start the simulation in the CAD view.  
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As PowerINSPECT OMV simulates the inspection sequence, the 
movements of the measuring device are shown in the CAD view, 
and the program status and current feature are displayed in the 
Progress area at the top of the Run tab. Any problems with the 
probe path are displayed in the Error handling list. For more 
information, refer to the online help. 

6 Use the other buttons on the Simulate Program tab to control the 
simulation. Click: 

to simulate the inspection sequence, or selected range, one 
item at a time.  

 to simulate the inspection sequence, or selected range, one 
move at a time.  

 to pause or suspend the simulation. Click once to pause the 
simulation when measurement of the current feature is 
complete. Click twice to pause the simulation when the current 
move within the probe path is complete. 

 to stop the simulation immediately. 

 to rewind the simulation back to the start. 

 to step back one feature at a time. 
 

Resolving verification faults 
Use the details displayed about the fault to locate and resolve the 
cause of the fault. For example: 

  
Fault Resolution 
Out of bounds 
move (yellow). 

Reposition the part. 

Collision with the 
part (orange). 

Edit the item's probe path and try: 
 deleting or moving touch points in the probe 

path. 
 inserting intermediate points into the probe 

path. 
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Fault Resolution 
An unexpected 
unverified probe 
path (grey).  

 

Check that: 
 the probe used for the probe path is 

available. 
 the probe supports the orientation specified 

in the probe path. 

The probe is not 
displayed in the 
Simulate Program 
tab and most 
entries in the 
Features tab are 
not editable. 

The probe specified for the selected item is not 
available in the probe database.  
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Adding further details to the inspection 
sequence 

We'll now look at adding further details to the inspection sequence, 
including: 

 a 3D feature (see page 27). 

 a surface inspection group (see page 28). 

 how to export only part of the inspection sequence (see page 
50). 
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Creating a cylinder 
In addition to creating items from 2D features, the Wireframe 
Checker (see page 17) can also be used to create 3D items, such as 
cylinders. To do this, you must change the Checker's picking mode.  

To create a cylinder item: 

1 Select the Features tab. 

2 Select the Wireframe Checker  button. 

3 Right-click the CAD view and select Surface from the context 
menu. Left-click the CAD view to close the menu. 

4 Move the cursor over the cylinder shown below, and left-click to 
select it. 

 
5 To see the whole cylinder, select the Show Transparent button in 

the Shading toolbar. 

 
6 In the Features tab, enter the following values: 

Z -3.0 

Depth - 6 mm  
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Probing depth - 3 mm  

Safe Height - 40 mm. 

 

7 Click  to create the Cylinder item. Because items cannot be 
added to the Definition level of the inspection sequence, 
PowerINSPECT OMV automatically creates and opens a new 
geometric group to hold the cylinder item. 

 

Creating a CNC surface inspection group 
Surface inspection groups enable you to inspect non-geometric 
surfaces on a part, and to compare the results with the CAD model. 
You can display the results in the CAD view using the Inspection 
Point Display options in the View Options toolbar, or view detailed 
information about each point using the Report and Info tabs. 

To create a surface inspection group: 

1 In the Sequence Tree, click  to close the geometric group 
and display the Definition level of the inspection sequence. 

2 In the Item toolbar, click  to create a CNC surface inspection 
group in the inspection sequence. 



 

PowerINSPECT OMV 2016 Quick Start Guide Tutorial example • 29  

3 Double-click on a face of the CAD model to specify the points you 
want to inspect. Position the first point on the main face, then 
add points on the surface. For example: 

 
4 In the Features tab, change the probing method from Optimal to 

SafePlane. 
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The path changes to move the probe to the safe plane between 
each point. For example: 

 

5 Enter a Safe Height of 40 mm: . 

6 Click  to create the item.  
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Positioning the probe is an important part of creating an inspection 
sequence. It prevents damage to equipment, and also ensures the 
accuracy of your measurements. PowerINSPECT OMV enables you 
to control probe positioning using two methods: 

 Automatic orientation (see page 32). 

 Orientation point items (see page 34). 

 

Positioning the probe 
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Using automatic orientation 
Automatic orientation positions the measuring device so that the 
probe is normal to the feature to be measured. Use it when you do 
not want to specify the probe orientation with which a feature is to 
be measured. 

For example, to set the automatic orientation for an inspection 
group: 

1 Select the Sequence Tree tab. 

2 Select the Features tab. 

3 In the inspection sequence, select the inspection group. 

4 Click  to edit the item's settings. 

5 Click the Auto-Orientation  button. 

6 In the Probing method list, select the UserDefined probing 
method of Optimal. 

 

7 Click the Use probe safe parameter  button to specify the safe 
height to be used when measuring the feature. For an Optimal 
method, this sets the approach distance before the first probed 
position, and the retract distance after the last probed position.  
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8 Click  to view the parameters that determine the probe path 
for the selected probing method, then close the Parameters 
dialog. 

 Only advanced users should change the probing 
parameters. If the standard probing methods included with 
PowerINSPECT OMV do not meet your needs, contact your 
sales representative to discuss your requirements. 

9 Click the Save geometric feature  button to save your 
changes. 
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Orientation Point items 
Use the Orientation Points item to control the position and rotation 
of the probe during multi-axis probing. Use it when you want to set 
or change the probe orientation in the inspection. 

 Orientation points are not available with all licenses.  

To create an Orientation Point item: 

1 In the Item toolbar, click . The Orientation Point dialog is 

displayed in the Features tab, and the orientation point  
symbol is displayed in the CAD view at the CAD Datum. 

 To hide the symbol in the CAD view, click the light bulb 
displayed next to the Orientation Point item in the inspection 
sequence. 

2 Complete the orientation point settings: 

 Reference datum — Select an entry in this list to specify the 
datum you want to use as the orientation point origin. 

 Load — Click  to load the orientation point settings from a 
previously saved file. 

 Save — Click  to save the current settings to a file. 

 Align — Click  to align the axes of the orientation point with 
the Reference datum. 

 Reset — Select to move the orientation point to the origin 
of the Reference datum. Deselect  to leave the orientation 
point in its current position.  

 Position — Enter coordinates in the X, Y and Z boxes to 
specify the location of the orientation point relative to the 
Reference datum. The position of the orientation point in the 
CAD view is automatically updated when you select another 
box. 

 Translate — Use this box to change the location of the 
orientation point relative to the current Position. For example, 
to change the X position of the point by 10 mm, type 10 in the 
box, and click . 
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 Rotate — Use this box to rotate the orientation point relative 
to the Reference datum. For example, to rotate the orientation 
point by 45 degrees in the Y axis, type 45 in the box, and click 

. 

 Undo — Click  to cancel the previous change. 

 Redo — Click  to cancel the previous undo. 

The orientation point symbol moves in the CAD view as you enter 
each change. 

3 Click  to create the orientation point, or click  to cancel 
your changes. 

4 Click  to simulate the orientation point. Alternatively, use the 
Simulate Program tab to simulate the orientation point in the 
inspection sequence. 

 Simulated moves may not match the moves of the machine 
tool exactly. 

 

Using orientation points 
Orientation point items can be placed anywhere in the Definition 
level of the inspection sequence. They can also be used within a 
geometric group to orient the probe before or after any item.  
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The following example illustrates the use of Orientation Points in the 
inspection sequence: 

 
  

 The inspection sequence starts by using the default (Machine 
Datum) to position and orient the probe. 

 The probe is transformed by Orientation Point 1. 

 In Inspection Group 1, Auto-Orientation is selected for the 
group's UserDefined probing method, so the probe is 
transformed before probing begins.  

 If Auto-Orientation is not selected, the probe remains at 
the rotation specified in Orientation Point 1. 

 In Circle 2, Auto-Orientation is not selected, so, before the 
first point on the Circle 2 probe path is played, the probe is 
transformed back to Orientation Point 1 because it is the 
preceding orientation point.  

 Orientation Point 2 transforms the probe for Cone 1. 

 Inspection Group 2 does not use Auto-Orientation, so the 
probe uses the orientation of Orientation Point 1 because it is 
the preceding orientation point item at that level in the 
inspection sequence.  

 When the probing of Inspection group 2 is complete, the 
probe is transformed by Orientation Point 3. 
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 If Geometric Group 2 contains any item in which Auto-
Orientation is selected, the probe is transformed by the 
associated probing method. Otherwise, the probe remains at 
the rotation specified in Orientation Point 3. 
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This section describes how to: 

 export the inspection sequence to the machine tool (see page 
39). 

 run the NC program (see page 41). 

 import data from the measured NC program  (see page 42). 

 

Measuring an inspection 
sequence 
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Exporting the inspection sequence to 
the machine tool 

When you have checked the inspection sequence and resolved any 
faults in the probe path, you can convert it to an NC Program file 
and export the file to the machine tool. 

To export the probe path: 

1 Select the NC Program tab. 
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2 Click  to export the alignment features. PowerINSPECT OMV 
verifies the probe paths, and displays the Probe Path Export 
dialog. 

 
3 In the Format list, select NC program + CLDATA file. 

4 Select the Post Processor option file for the machine tool on which 
you want to run the probe path. 

5 In the NC Program file box, enter the location and name of the 
file in which you want to save the inspection sequence. 

6 In the Part Name box, enter the name of the part to be 
measured. 

7 In the Tool Number box, enter the tool number to be used when 
running the probe path. (This sets the tool number and the tool 
offset number.)  

8 If your machine has rotary axes and no RTCP support, enter the 
distance from the probe tip to the gauge face of the spindle in 
the Gauge Length box.  

9 In the WPCS box, enter the work piece coordinate system 
number that you want the machine tool to use when measuring 
the part.  
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 On some machine tools, the WPCS is referred to as the 
work offset. 

10 Click OK to create the NC program file. 

You can now run the OMV inspection sequence on a machine tool 
(see page 38). When you have imported the point data into 
PowerINSPECT OMV, you can continue to add further details to the 
sequence. 

 

Running the NC program 
The PowerINSPECT OMV NC program (tape file) contains the 
probing moves specified in the inspection sequence. When you run 
it on a machine tool, it outputs the measurement results to a serial 
port or file, depending on the machine tool and the post-processor. 

Before running the NC program on the machine tool, check: 

 the tool number in the NC program matches the number of the 
probe in the machine tool's magazine. 

 the work offset on the machine tool matches the WPCS 
(workpiece coordinate system) in the NC program. 

 import details have been specified in PowerINSPECT OMV (see 
page 42) if you are importing the data using a serial connection. 
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Importing measurements into 
PowerINSPECT OMV 

To import measurement results into PowerINSPECT OMV: 

1 Select the Run tab. 

2 Select the NC Program tab. 

3 Click  to display the Importer Configuration dialog. 

 
4 Select the Custom tab and enter the location and name of the 

default parser file, reader_psfixture.rsf, in the Script file name box. 
The file is located in the \OMVReaders folder of your installation. 

5 Select the Session tab. 

6 Choose an import method. Select:  

 File to import the point data from the measurement file 
created by the machine-tool controller. Enter the location and 
name of the file you want to import in the adjacent box. 
Alternatively, click  to select the file. 

 Serial port to import the point data directly from the serial port 
connection of the machine-tool controller. When you first use 
this option, click Configure and ensure PowerINSPECT OMV's 
serial configuration settings match those required by the 
controller. For more information on the serial configuration 
settings required, refer to your controller's documentation. 

7 Click OK to save your changes and close the dialog. 
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8 In the NC Program tab, click  to import the measurement 
results from the machine tool. 

The NC Program tab displays the details of the import as it 
progresses. 

 
Where: 

  shows the name of the inspection sequence item being 
imported. 

  shows the minimum number of points required to measure 
the item. 

  shows the number of points received for the item. 

  shows the progress for the current item. 

  lists the details of the imported items. When the import is 
complete, a summary is displayed, for example: 
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Displaying the measurement results 
There are several ways to view measurement results in 
PowerINSPECT OMV. This section describes how to display them in: 

 An on-screen report (see page 45). 

 An HTML report (see page 46). 
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Creating an on-screen report 
The Print Preview option enables you to quickly print the 
information displayed in the current view. 

 
To create an on-screen report of the CAD view: 

1 Select the CAD view tab. 

2 Position and size the model in the CAD view to display the 
features you want to include in the report.  

3 Select the information you want to display. For example, to 

display the feature information in labels, click  in the View 
Options toolbar. 

4 If you want to hide the labels of any of the items, click the show 
 icon on the item's entry in the inspection sequence. If you 

want to change the information displayed in each label, click 

. 
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5 With a display format selected, click  to preview the report.  

6 If you want to change the details shown in the report, click Close 
and adjust the CAD view, otherwise, click Print to print the on-
screen report. 

 

Creating an HTML report 
HTML reports provide you with detailed numerical and graphical 
information on the measurements in the current document. You can 
customize reports for specific jobs or specific customers.  

To create an HTML report: 

1 Click the Report tab. PowerINSPECT OMV generates the report. 

2 Click  to preview the report. 
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3 Click  to print the report. 

4 If you want to export the report for viewing in a browser, click 

the Export Report  button to save the report in .mht format. 
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Optimizing the alignment (Best Fit) 
When you have measured one or more inspection, section or point 
cloud groups, you can use Best Fit items to optimize the alignment 
of the part with the CAD model. PowerINSPECT OMV compares the 
points of selected groups to the nominals and adjusts the alignment 
using one of five fitting methods. 

To optimize an alignment: 

1 Open the file BestFitExample.pwi from the Samples folder. 

2 Click  to activate the Best Fit option. 

 
3 In the Fitting type list, select Best Fit - ignore tolerance band to 

minimize the deviations of all the points. 
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4 In the Available items list, select the item you want to use to 
optimize the alignment and click  to move it to the Selected 
items list. To move all the items to the Selected items list, click 

. 

By default, all items in the Selected items list have an equal effect 
on the best fit calculation. If you want to assign greater 
emphasis to the measurements in specific items, click the 
Weights cell for the item, then type a multiplier in the entry box.  

5 Click Apply. A Best Fit item is added to the inspection sequence. 

 
6 Right-click the Best Fit item and select Play. The Best Fit Analyser 

dialog is displayed. 
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7 Click Go Step to activate the Best Fit. 

 
A graphical representation of the deviations is shown: the green 
line shows the deviation prior to the Best Fit calculation, and the 
red line shows the deviation following the calculation. This 
updates all previously measured results. 

 If a best fit is applied, reports should only be generated 
after this is complete. 

 

Exporting a section of the inspection 
sequence 

The range commands enable you to run only part of the inspection 
sequence. Ranges apply to the simulation and the NC program 
export, so you can use them when you only want to rerun changes 
made to previously measured sequence items. 

To export only Geometric Group 2 and the following inspection 
group:  
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1 Select Geometric Group 2 from the inspection sequence, right 
click and select Start of Range from the context menu. 

 
Range indicators are displayed in the inspection sequence to 
show the items that are included. By default, the range extends 
to the last item in the sequence. If you do not want to run the 
inspection sequence to the end, you can specify the last item in 
the range using the End of Range menu option. 

2 Export the NC program (see page 39) as you did earlier. This 
time, only the selected range is exported. 
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The Tools > Import Points menu options enable you to create a probe 
path from a text file containing coordinates of nominal points, such 
as a comma separated file of coordinates in an XYZIJK format. 
To create a probe path from imported points: 

1 Open a document that contains the model associated with the file 
to be imported,  

2 Select: 

 Tools > Import Points > Create Surface Inspection Group to 
create a surface inspection group from the file's points. 

 Tools > Import Points > Create Geometric Points to create a 
geometric group of single points from the file's points. 

Creating a probe path 
from imported points 
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The Import Points wizard is displayed. 

 
3 Click Browse. In the Open dialog, locate the points file you want 

to import. 

If PowerINSPECT OMV recognizes the file extension, it displays 
descriptions of the file types under the Possible Formats tab. 

4 Select the required format. If no format is displayed in the 
Possible Formats box, click the All Formats tab and select the 
format from the list displayed. 
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5 If you want to preview how the selected format interprets the 
point coordinates in the file, click Preview. For example: 

 
Click OK to close the window. 

6 When you have selected the file format, click Next to view a 
summary of the import options: 

7 If you are satisfied with this summary, click Next to proceed. 
Otherwise, verify the options using the Preview button before 
proceeding. If you want to change the file format, click Back and 
proceed from step 4. 

PowerINSPECT OMV starts importing the points into a new group. 

When the import is complete, PowerINSPECT OMV displays the 
points in the CAD view and a message confirms the creation of the 
group in the inspection sequence, and the number of points used to 
create it. The probe path is displayed when you close the wizard. 

For an example of the creation of a surface inspection group from 
imported points, refer to Tools > Import Points > Create Surface 
Inspection Group in PowerINSPECT OMV's online help. For an 
example of the creation of a geometric group, refer to Tools > Import 
Points > Create Geometric Points. 
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